Guide to User Interface 4.4 and 4.4.1
Reissued Manual as of May 2, 2013

This is a new edition of the Guide to User Interface 4.4 and 4.4.1 manual. This edition replaces the previous edition dated May 25, 2012.

UI 4.4.1 is an optional software upgrade that contains enhancements that are targeted for users of Freedom Scientific JAWS (Job Access With Speech) software. All information in this manual applies to both UI 4.4 and 4.4.1; therefore, any references to UI 4.4 are also applicable for UI 4.4.1.

The Primary Changes Made

The table below lists the changes made in this version of the manual.

<table>
<thead>
<tr>
<th>Section</th>
<th>Pages</th>
<th>Changes Made</th>
</tr>
</thead>
<tbody>
<tr>
<td>What's New in UI 4.4.1</td>
<td>11</td>
<td>UI 4.4.1 is an optional software upgrade that enhances the UI experience for JAWS users. You do not need to upgrade your software from UI 4.4 if users do not require these enhancements.</td>
</tr>
</tbody>
</table>
## Table of Contents

### 9 Colleague User Interface

#### 11 About Colleague UI

- In This Chapter
- What’s New in UI 4.4.1
- What’s New in UI 4.4
- Colleague UI Features
  - Window Resizing and Form Scaling
  - Search Field
  - LookUp Search Results
  - Features in Colleague Forms
    - Right-Click for Cut, Copy, and Paste
    - Table Controller
    - Background Toggle Button
    - Export to Excel
  - Table Page Numbers
  - Print Form Button
  - UI Color Preferences
  - User Display Preferences
  - Comments Dialog Box
  - Report Browser
  - Map Window
  - Expanded View of All People in Context
- Query Builder is Not Accessible From UI
- AnswerNet Change Requests Resolved With UI 4.4

#### 21 Logging Into Colleague UI

- In This Chapter
- Procedure for Logging Into Colleague UI

#### 25 Navigating Colleague UI

- In This Chapter
- The UI Window
  - Parts of the UI Window
    - Search Area
  - Tabs
  - Menus
  - The Context Area
  - The Form Area
- Colleague Forms in UI
Table of Contents

35 Form Mnemonic and Name
35 Fields
36 Tables
38 Detail Button
38 Date/Calendar Button
39 Drop-Down List Button
40 Accessing Forms and Information
40 Person Search
40 Person Search Results Panel
46 Advanced Person Search
48 Form Search
49 Selecting a Form
49 Opening a Form
50 Sorting Results
50 Navigation Panel
52 Favorites Panel
52 Adding a Person or Form to Favorites
53 Selecting People from Favorites
53 Selecting a Form from Favorites
54 Selecting People and Forms Together from Favorites
54 Managing Favorites
56 LookUp
57 Using LookUp to Find Records
57 LookUp Shortcuts
64 Adding Records from a LookUp
65 Uploading and Downloading Files
65 Uploading Files to Colleague
67 Downloading Files from Colleague
69 Running Batch and Report Processes
70 Using the Report Browser
70 Procedure for Browsing a Report
77 Accessing Multiple Environments
78 Keyboard Shortcuts
81 Using UI Without a Mouse
82 Viewing Online Help in UI

85 Customizing Colleague UI

85 In This Chapter
86 Defining User Preferences
88 Adding and Accessing Favorites
88 Adding Favorites
89 Accessing Favorites
94 Customizing the Field Sequence and Properties for a Form
<table>
<thead>
<tr>
<th>Page</th>
<th>Section</th>
</tr>
</thead>
<tbody>
<tr>
<td>96</td>
<td>Limitations on Customizing Field Properties</td>
</tr>
<tr>
<td>96</td>
<td>Field Sequence Customization Limitations</td>
</tr>
<tr>
<td>96</td>
<td>Field Access Customization Limitations</td>
</tr>
<tr>
<td>97</td>
<td>Procedure for Customizing Fields on a Form</td>
</tr>
<tr>
<td>99</td>
<td>Procedure for Disabling Field Sequence</td>
</tr>
<tr>
<td>100</td>
<td>Procedure for Showing Field Sequence</td>
</tr>
</tbody>
</table>
Guide to User Interface 4.4 and 4.4.1
Colleague User Interface
About Colleague UI

In This Chapter

This chapter summarizes the enhancements made to Colleague® by Ellucian User Interface (UI) 4.4 and 4.4.1 and highlights special features in UI.

What’s New in UI 4.4.1

UI 4.4.1 is an optional software upgrade that enhances the UI experience for Freedom Scientific JAWS (Job Access With Speech) users. All references in this manual to UI 4.4 are also applicable for UI 4.4.1.

A new manual, titled Guide to User Interface 4.4.1 for JAWS Users, has been introduced to provide information about the issues that UI 4.4.1 resolves, descriptions of the new accessibility features, recommended settings, and keyboard shortcuts.

The new manual is intended to capture the features that are the most meaningful to JAWS users. It is not comprehensive and does not replace this manual.

For more information about UI 4.4.1, see the Guide to User Interface 4.4.1 for JAWS Users manual.
What’s New in UI 4.4

UI 4.4 offers the following enhancements:

- **Sort/Select option in Search Results.** You can use the Sort/Select option to further reduce or sort the results in the Search Results panel for all non-form searches and LookUps performed from within a form. This option is not available for form searches from the form search text box.

- **Jump to record in Search Results.** In the Search Results panel, you can search for a specific result by its number for all non-form searches and LookUps performed from within a form. The page that the record is located on is displayed. This option is not available for form searches from the form search text box.

- **Select All option enhancement in Search Results.** In the Search Results panel, you can now first select all records and then clear individual records to include only the records that you want. This option is not available for searches that require a single selection.

- **Add form to Favorites in Search Results.** You can select and add forms to your Favorites in the Search Results panel.

- **Full page view within the Report Browser.** You can display one full vertical page of a report in the Report Browser without scrolling. This option is enabled as a UI preference and within the Report Browser, though it can be changed.

- **Options to open PDF files directly within a browser.** Report Browser information in the help and the manual include instructions on how to set your browser to open PDF files directly in the browser rather than downloading and saving them first.

- **Support for screen reader software.** There are many improvements within UI to provide support for screen reader software, such as JAWS.

- **Person privacy enhancements.** There are additional changes to the person privacy feature to make it more apparent that a person-related record in the Context Area has an associated privacy message.

- **Alert sound available for dialog boxes.** You can set a preference to play an alert sound when an error or other important dialog box is displayed.

- **Additional keyboard shortcuts.** Additional keyboard shortcuts are available to support screen reader software options and to quickly change the focus between a UI form and the Context Area.

- **Form tables enhancement.** You can hover over tables in forms to view the page numbers instead of clicking in the tables.

- **Copy/paste improvements in forms.** The option to right-click in a form field and paste data has been improved.
Colleague UI Features

Window Resizing and Form Scaling

When Colleague displays a form, it automatically resizes to minimize scrolling for the default window size. You can also move the form scale slider (see Figure 1) to resize the current form and make the information larger or smaller as needed. Colleague will remember the setting the next time you open that form. Go to the Options menu to manually set the scale for all your forms at once.

Figure 1: UI Form Scale Slider

Search Field

The Search field uses icons and text prompts (see Figure 2) to switch between Person Search and Form Search. You can click the icon to the left of the search text box to switch between searching for a person (human figure icon) or a form (computer screen icon).
LookUp Search Results

The Search Results panel (see Figure 3) allows the flexibility to view things like purchase orders or code files in a grid view, and sort on any column of data that is displayed.

Add the Search Results additions here...

Figure 3: UI LookUp Search Results
Features in Colleague Forms

Right-Click for Cut, Copy, and Paste

You can cut, copy, or paste text in any field on a UI form. Select the text and right-click to access these options, or use the standard keyboard shortcuts (Ctrl+X, Ctrl+C, and Ctrl+V).

Table Controller

Whenever a field is in focus within a table on a UI form (where the fields are organized in rows and columns), you can “page down” to see more rows. A table controller is provided (see Figure 4) to make moving around and viewing the rows and pages of data easier.

Figure 4: UI Table Controller

Background Toggle Button

When the table controller appears on a UI form, you can toggle between regular and transparent table backgrounds. (see Figure 4).

Export to Excel

When the table controller appears on a UI form, you can select the Export to Excel button to export all rows of data to a spreadsheet (see Figure 4).
Table Page Numbers

To view the page numbers in tables, you can hover over the table to view a tooltip instead of clicking in the table (see Figure 5).

Figure 5: Table Page Numbers

Print Form Button

The form area includes a Print Form button (see Figure 6), which allows you to directly print the current form along with the Person in context associated with the form.

Figure 6: UI Form Print Button

UI Color Preferences

From the Preferences dialog box, each user can select a color theme and one of the available form background colors (light, medium, or dark) to adjust the contrast between the background of a Colleague form and the text fields (see Figure 7).
User Display Preferences

From the Preferences dialog box, each user can identify display preferences for various features (see Figure 8).
Comments Dialog Box

A pop-up Comments dialog box (see Figure 9) displays messages for some forms. If you are allowed to create or edit comments in the dialog box, you can easily insert a date/time/login ID stamp into the comments using the Timestamp button.

Note: You can also enter the pound sign (#) followed by Enter to insert a date/time/login ID stamp.

Figure 9: UI Comments Dialog Box

Report Browser

UI provides a report browser with export to PDF or print options (see Figure 10).

Figure 10: UI Report Browser
Map Window

If allowed by your institution, a map window is provided (see Figure 11).

Figure 11: UI Map Window

Expanded View of All People in Context

The View All Records in Context button provides an expanded card view, spreading out the cards so you can view or select several at one time. From this view, you can select one or several people to map, save as Favorites, or remove from context.
Figure 12: View All Records in Context

Click the View All Records In Context button...

...to spread out all cards currently in context.

Query Builder is Not Accessible From UI

Query Builder, a wIntegrate utility, is not accessible from UI in UI 4.2 or later. If you normally use Query Builder to do your work, see your Colleague System Administrator for details on how to continue using this utility.

AnswerNet Change Requests Resolved With UI 4.4

Many AnswerNet change requests were resolved with the release of UI 4.4. See your Colleague System Administrator if you need more details about the change requests that were resolved with this release.
Logging Into Colleague UI

In This Chapter

This chapter provides you with information about accessing and logging into Colleague User Interface.
Procedure for Logging Into Colleague UI

Complete the following steps to log into Colleague UI. Your Colleague System Administrator will provide you with a web address (URL) for accessing a specific Colleague UI environment (such as test or production). Each Colleague environment has its own web address for starting UI. If you are using Colleague Portal, you can access Colleague UI from the Portal page.

**Note:** For UNIX systems, the login dialog box will include an option for changing your password if your Colleague System Administrator has enabled this feature.

**Step 1.** Start UI on your PC by opening your web browser and going to the web address provided by your Colleague System Administrator.

The **Login** dialog box is displayed.

**Figure 13: Login Dialog Box**

![Login Dialog Box](image)

**Step 2.** Enter your Colleague user ID and password.

**Step 3.** Click **Login**.

The Quick Tour window appears, providing you with the option to view a presentation about the main features available in this version of UI.

**Technical Tip:** Select the **Don’t Show Me Again** check box if you do not want the Quick Tour window to appear each time you log in. You can access the Quick Tour at any time from the **Help** menu.
Step 4. Click the Play arrow if you want to view the Quick Tour presentation.

Click Close if you want to open Colleague UI without viewing the Quick Tour.
Navigating Colleague UI

In This Chapter

This chapter helps you learn how to use Colleague User Interface. It includes instructions for accomplishing various tasks, such as accessing a form, saving your work, and using online help.

Technical Tip: If you are familiar with earlier versions of UI, see "About Colleague UI" beginning on page 11 for information about UI features and enhancements.
The UI Window

UI is a user-friendly, intuitive interface for Colleague.

If you are familiar with Colleague in the UI Desktop or UI Web interfaces, you may notice that this interface is very similar, but with some features not previously available. See Figure 14 for an example of the UI interface. See “Parts of the UI Window” beginning on page 27 for more details about each of the areas of the UI window.

**Figure 14: The UI Window**

The UI Quick Tour provides a brief overview of many of the UI features. To access the quick tour, select the **Quick Tour** option from the **Help** menu (see Figure 15).
Parts of the UI Window

The UI window has the following areas to help you work with Colleague easily and effectively.

Search Area

The search area of the UI window, in the upper left corner (see Figure 16), lets you search for people or forms to work with. You can click the icon to the left of the search text box to switch between searching for a person (human figure icon) or a form (computer screen icon). In this area, you can also expand the search box to view previous searches or click Edit Search History to clear some or all of your search history.

If allowed by your institution, you can search for a person or organization by clicking the Person icon and then entering information such as the name or ID number in the search box. You can also click the Advanced Person Search icon (magnifying glass icon to the right of the Search button) to search for person-related records using multiple customizable search parameters, such as part of the address and class standing. For either search option, the Search Results panel displays all person records that match the search criteria you entered. See “Person Search” on page 40 for more details.
To search for a form, type the mnemonic or words from the title of the form in the search box. In most cases, when you enter the mnemonic for a form in the search box, the form opens immediately. When you enter one or more words from the title of the form, the Search Results panel displays all matching forms.

Some forms require you to also select the application that you want to open them in. After you enter the mnemonic for one of those forms, Colleague prompts you for the application. You can also open those forms immediately by entering the application mnemonic and the form mnemonic together, separated with a hyphen. For example, enter "CORE-NAE" or "VAL-ST". Forms opened in this way are not stored in your search history. See “Form Search” on page 48 for more details.

**Figure 16: The Search Area**

![Search Area Diagram](image)

**Tabs**

**Figure 17** shows the following tabs available in the UI window:

- **Search Results Tab.** When you search for a person or form, the search results appear on the Search Results panel. Search results from other LookUps are also displayed on the Search Results panel. This panel is hidden after you select the records or form you want. When the panel is hidden, you can click the Search Results tab to return to the results of the last search. If the person icon is selected in the search area, the last person-related search results are shown. If the form icon is selected in the search area, the last form search results are shown.

**Note:** The Search Results panel only retains the results of the most recent form search or person search performed from the Search Area. Prior search results from LookUp prompts on UI forms are not retained on the Search Results panel.
- **Navigation Tab.** Click the **Navigation** tab to access a Colleague form by navigating through the Colleague menu structure, which you can use to view and access all menus and forms that you have permission to use. Use the Application drop-down menu to view the menu structure for any available application.

- **Favorites Tab.** Click the **Favorites** tab to access all people and forms that you have saved as Favorites. You can save an item to Favorites by clicking the **Add to Favorites** (gold star) button in the Context Area (for person-related records), the UI Form Area (for forms), or while in the **Favorites** panel.

**Figure 17:** Tabs in the UI Window

---

**Menus**

With UI, menu items are available on the left side of the tool bar (which is just above the form area). These menus provide access to many of the UI controls and features.

**File Menu**

The **File** menu provides access to the following features. Many of these features are also available using keyboard shortcuts:

- **Save.** Saves data on the current form.
- **Save All.** Saves data on all open forms.
- **Finish.** Saves data on all open forms and closes all open forms.
- **Cancel.** Cancels changes on the current form.
- **Cancel All.** Cancels changes on all open forms.
- **Record Delete** (if enabled). Deletes the record on the current form. Your Colleague System Administrator controls access to this feature.
- **Detail.** Accesses the detail form, or a menu of available forms, from the current field.
- **Add Active Form to Favorites.** Adds the current form to Favorites.
- **Print Form.** Prints the current form (size is optimized for the page).
- **Logout.** Exits UI.
**Options Menu**

The **Options** menu provides access to the following features. Many of these features are also available using keyboard shortcuts:

- **Preferences.** Accesses the Preferences dialog box, where you can change preferences such as the color theme and other user settings.
- **Clear Search History.** Accesses the Clear History dialog box, where you can clear search history, contexts, and form scale values.
- **Reload Colleague Session.** This option lets you refresh your session with software updates that may have been made or loaded into the environment while you were logged in. This feature is used primarily in Colleague development environments.
- **Change Password** (if available). Allows you to change your password.
- **Show Field Sequence.** Shows the current tab sequence for fields on the current form.
- **Disable Custom Field Sequence** (if available). Restores the default tab sequence for fields on the current form. If selected, this option applies to all forms in a UI session until this option is cleared.
- **Customize Field Properties** (if available). For the current form, allows the user to customize the default tab sequence for fields and mark fields as required.
- **Set Form Scale Default.** Sets the global default scale factor for all forms to the current scale factor (set using the slider bar at the top of the UI form area). Forms with individual scale factor overrides are not affected by this global default.
- **Clear All Form Scale Values.** Clears all individual form scale factors and the global default scale factor. Without these scale values, forms are rendered using a “best fit” algorithm based on the size of the UI window.

**Help Menu**

The **Help** menu (shown in Figure 15 on page 27) provides access to process and field help for the current Colleague form. It also provides access to the quick tour, a list of all keyboard shortcuts, and a Help About message that provides information such as the current UI version number. Your Colleague System Administrator can also add custom menu items to this **Help** menu to provide easy access to procedures and other information that is specific to your institution.

In addition to the **Help** menu, help buttons are available in many areas of the UI window. The help buttons look like question marks, and they usually appear in the upper right corner of a specific area, panel, or dialog box. These help buttons provide information specific to the related feature. For example.
the help button in the top right corner of the UI window provides an overview of the UI interface and its features. The help button in the Context Area provides specific information about using the features of the Context Area, and the help button on the Favorites panel provides specific information about working with Favorites.

Technical Tip: Depending on your browser settings, online help may appear in a new browser window each time you access help, or it may re-use the same browser window to display all help messages. If your browser re-uses the same window for all help messages, that window may not always come to the foreground when you access help.

Information on how to customize this menu is available in the User Interface 4.4 and 4.4.1 Installation and Administration manual.

The Context Area

The Context Area (see Figure 18 on page 33) displays one or more “cards,” which contain information about the current person-related records that you are working with. The information shown in the Context Area cards can be customized at your site. If you have questions or would like to propose changes in what is shown in the Context Area, contact your Colleague System Administrator. The Context Area currently displays information only for person-related forms.

If the Context Area is blank, use the Person search feature to select Person or Organization records to work with. When you open the selected records, they are loaded into the Context Area as “cards.” If you have opened a person-related form first (with no cards in the Context Area), you can use LookUp to search for records and load them into the Context Area as cards.

Person Cards can include photographs (if set up by your institution) and other identifying information about the person (such as name, address, and ID). Your institution can customize the information shown on the Person Cards. Organization Cards include similar identifying information but do not include photographs.

The Context Area can hold person cards, organization cards, or both (depending on the form you are working with). When multiple cards are loaded into the Context Area, you can use the Next and Previous buttons to scroll through the cards.
You can also select **View All** to see all cards currently in context (see Figure 19 on page 33). When viewing all cards in context, you can go to a specific card, or you can select one or more records to map, add to Favorites, or remove from context.

If privacy codes are enabled at your institution, privacy messages for a person display over the Context Area. If you have selected the **Play Sound on Popup Messages** check box from the **Options > Preferences** menu, an alert sound will play to let you know that a privacy-controlled card was loaded. Click the **Close (x)** button to close the message or switch to another card.

An exclamation mark indicator (!) in the far left of the card title area indicates that a privacy message is available for a person. Click this indicator to view the privacy message again. If the privacy settings do not allow you to access a person’s record, you will only be able to see the name and ID of the person, with a message stating that the record is not accessible because of privacy settings.

If allowed by your institution, you can click the **Mapping** (push pin) button to map the addresses of the current card or all cards in the Context Area.

Click the **Add to Favorites** (gold star) button to add the current card or all cards to your People Favorites.

Click the **Launch Copy Window** (green page) button to open a new browser window with the contents of the current context card in a format that lets you select and copy the text and then paste it into another application. If you only want to copy one field of information from the Context Area, you can select and copy it directly from the context area without opening the copy window.

Click the **Context Area Help** (question mark) button to access the online help for the Context Area.

Click the **Close (x)** button to close the current card or all cards in the Context Area.

Many of the features in the Context Area are accessible through keyboard shortcuts. See “Keyboard Shortcuts” on page 78 for a full list of all available keyboard shortcuts.

Colleague Administrators can customize the information shown in the Context Area. For more information, see your Colleague System Administrator or the *User Interface 4.4 and 4.4.1 Installation and Administration* manual.
The Form Area

The Form Area displays the Colleague forms that you are currently working with. See Figure 14 on page 26 for an example of the Form Area.

Several features are available in the tool bar at the top of the Form Area, including menus (see page 29 for a description), Context option, Save and Cancel buttons, the Form Scale Slider, and the Form Print button. The Save
All and Cancel All buttons enable you to save or cancel all of your changes simultaneously to every form that is currently open in this session. The Save and Cancel buttons enable you to save or cancel changes to the current form.

Note: The Context option allows you to specify what you want Colleague to do with open contexts when you save or cancel from a form. The Auto-Close Context option also closes all contexts when you save the last card in the Context Area. This applies to person-related forms only.

Technical Tip: Cancel All does not cancel all changes made to all people in the context area. It cancels out of any detail forms and cancels changes to the current record only. When you move from one person to the next in the context area, you are prompted to save any changes made to the first person. Changes are saved automatically if your institution has final prompting turned off. (It is recommended that final prompting be turned on.)

Form and Window Size

UI was designed using a minimum screen resolution of 1024x768. If you need to make the whole UI window larger or smaller to fit the desired screen space on your computer, resize the window as you would any other window on your computer.

Each Colleague form is initially sized to fit within the given Form Area space. If you need to make a form larger or smaller, use the Form Scale Slider to zoom in or out. The form scale setting for individual forms is retained for future sessions.

To set a default scale factor for all forms, set the scale factor for the current form and use the Options > Set Form Scale Default option to set the factor for all forms. To clear all form scale values, use the Options > Clear All Form Scale Values option, and then click OK to confirm this action.
Colleague Forms in UI

See Figure 14 on page 26 for an example of a Colleague form in UI. This section describes each part of the form in more detail and provides information on how to use the features within a form.

Form Mnemonic and Name

The form name and mnemonic for the current form are displayed on a tab at the top of the form, just below the tool bar (see Figure 20). If one or more detail forms are also open, a tab is displayed for each form. The form’s mnemonic provides you with a quick way to identify a form.

Note: When multiple forms are open, each form has its own tab. The tab farthest to the right represents the active form. To ensure that each record is completed properly, only one form can be edited at a time. All forms below the current open form are inquiry only and do not allow input. Data on these forms is grayed out while another form is active.

Figure 20: Form Mnemonic and Name

Fields

A field is any place on the form where data is displayed or where you enter data. In most cases, each field is accompanied by a field label indicating what kind of data belongs in the field.

What you are allowed to enter in a field may be restricted by Colleague. For example, a field may allow you to enter only letters, or numbers, or specific values from a list. Standard data entry fields (such as the Country field on the Name and Address Entry form shown in Figure 14 on page 26) have a white background. Inquiry fields (such as the Person ID field on the Name and Address Entry form shown in Figure 14) have a shaded background. Required fields (such as the Last Name field on the Name and Address Entry form shown in Figure 14) have a white background with a red outline and a red dot in the upper left-hand corner.
Tables

A table within a form is a set of related fields. A table can have a different value on each line, or row. Furthermore, there are usually several fields in each row of a table that are associated with each other in some way. Some tables are row-oriented and some are column-oriented. In either case, the intersection of a column and a row is referred to as an element. On the Name and Address Entry form shown in Figure 14 on page 26, the Phone/Ext/Type group of fields is an example of a table. Each phone number entered can have an associated extension and type, and you can enter multiple phone numbers.

Table Operation Button

A Table Operation button enables you to insert or delete a row of data within a table.

Figure 21: The Table Operation Button

When you click the Table Operation button, a dialog box is displayed, as shown in Figure 22.

Figure 22: Select Table Operation Dialog Box

From the Select Table Operation dialog box, select one of the following options:

- Click Insert to insert a new row above the current row.
- Click Delete to delete the current row.
- Click Cancel to leave the row unchanged and return to editing.
Scrolling and Exporting

When your cursor is within a table, a controller appears at the top of the table that lets you scroll through the rows and pages of data (see Figure 23). This controller also includes a **Background Toggle** button that lets you make the background transparent and an **Export** button that lets you export the entire contents of the table to an Excel spreadsheet. You can also view the page numbers in tables by hovering over the table.

**Note:** Security restrictions apply to the fields exported to Excel. If you do not have access to a field in Colleague due to security, that field will not be exported to Excel.

If the controller blocks your view of another field on the form, you can click and hold the word “Page” on the controller to grab it, then move your mouse to slide it left or right. Release the mouse button to let go of the controller when it is at the desired location.

When the last row of data in the table is shown, you can click **Next Page** to access a new blank row. If the form allows it, you can add new data on this blank row.

**Figure 23:** Scroll and Export Controller

- Export to Excel Button
- Click and hold on “Page” to slide controller
- Click **Next Page** after last row to add a new row
- Background Toggle Button
- Scroll Buttons
**Detail Button**

Some forms give you only limited or summary information about a certain item, but provide you with the capability of moving to another form. This form, which is known as a *detail form*, provides more complete information on that item.

You will know a detail form is available from a field if there is a **Detail button** to the right of the field. Such fields are referred to as *detail fields*. See **Figure 24** for an example of a detail field with a detail button.

**Figure 24: Detail Button**

![Detail Button](image)

**Date/Calendar Button**

A **Date/Calendar button** appears to the right of each date field.

**Figure 25: The Date/Calendar Button**

![Date/Calendar Button](image)

Click the **Date/Calendar** button to display the calendar browser, as shown in **Figure 26**. Click the desired date in the calendar to select it.

**Figure 26: Calendar Browser**

![Calendar Browser](image)
Drop-Down List Button

A **Drop-Down List** button appears to the right of each field that has a predetermined set of valid entries. Click the **Drop-Down List** button to display a list of valid codes. Click the appropriate code to select it.

**Note:** You can also use the down arrow key to open the list, then use the up and down arrow keys to move through the list and highlight the entry you want. Press **Enter** to select it.

**Figure 27:** Drop-Down List

- Prefix: Mr., MR, MRS
- Name: LFM
- Suffix: MISS, Miss, MS, Ms.
- Address: DR, Dr.
Accessing Forms and Information

You can access forms and information in several ways:
- Person Search
- Form Search
- Navigation Panel
- Favorites Panel
- LookUp

Person Search

When you use Person Search or LookUp to search for person records (individuals, organizations, students, etc.), the results are displayed on the Search Results panel. The Search Results panel has two views: Card View and Grid View. Each of these views is discussed in more detail in the following sections.

Person Search Results Panel

When you search for a person or corporation, the search results show all records that match the search criteria you entered. When viewing search results in Card View, you can see photos (for people) in addition to other information about the records, such as addresses or phone numbers. Search results in Grid View are displayed in a spreadsheet format, with the results in rows and columns. You can sort the results on any available column, resize the columns if needed, and click and drag a column heading to rearrange the columns. You may have to scroll horizontally in the Search Results panel to see all available columns. The information displayed in the search results for both Card View and Grid View can be customized for your institution.

Note: Person photos are not available in Grid View. Photos are available in Card View only.

To switch between Card View (Figure 28) and Grid View (Figure 29), click the Card View or Grid View button at the top of the Search Results panel.
Figure 28: Person Search Results, shown in Card View

- Card View Button
- Grid View Button
- Select All Check Box
- Add New Record Button (disabled)
- Collapse Button
- Export to Excel Button
- Input Field
- Open Button
In both Card View and Grid View, you can hover over the Input field to view a tooltip with options that can be used in the field (see Figure 30).

**Figure 29: Person Search Results Panel: Grid View**

**Figure 30: Input Field Tooltip**

Enter records to select in the following format: 1,2-4,7

Or enter a command:

- **F** - select all records
- **A** - add a new record (if available on a form)
- **J x** - jump to result number x
- **S** - enter Sort/Select criteria (if applicable)
Selecting Records in Card View

To select a record to work with, click anywhere on the card. When you click anywhere on a card, the color changes to indicate that it is selected. You can double-click on a single record to select it and open it in the Context Area.

![Figure 31: Selecting Records Example](image)

To select multiple records, click on more than one card. Click on a selected card again to cancel the selection.

In the Input field, you can also enter the numbers of the records that you want to select, separated by commas for individual record numbers. Use a dash to enter a range of record numbers.

Use the Select All check box to select all search results. This option selects all pages of search results, not just the current page of results.

**Technical Tip:** Some forms do not allow you to select more than one record at a time.

Selecting Records in Grid View

To select a record to work with, click anywhere on the row for that record. When you click anywhere on a row, the color changes to indicate that it is selected. A triangle also appears in the left column to indicate that it is selected. Double-click on a single record to select it and open it in the Context Area.

To select multiple records in sequence, click on the first record that you want and then Shift+Click on the last record in the sequence. To select multiple person records that are not in sequence, click on the first record that you want and then Ctrl+Click on the other records.

You can also enter the numbers of the records that you want to select in the Input field, separated by commas for individual record numbers. Use a dash to enter a range of record numbers.
Click **Select All** to select all records shown in the search results. This option selects all pages of search results, not just the current page of results.

**Technical Tip:** Some forms do not allow you to select more than one record at a time.

### Opening Records

After selecting the records that you want to work with, click **Open** to add those records to the Context Area. If any records were already in the Context Area, new ones added from this search will appear in sequence immediately after the current card. The first card of the selected records will be in focus, and the current form will be populated with that record’s information.

### Exporting Records

To export search result records to a Microsoft Excel spreadsheet, click the **Excel** icon (to the left of the Input field). All search results records are exported to a spreadsheet. If the browser does not automatically open the spreadsheet, you are prompted to open or save it. When the export is complete, you can close both the informational window and dialog box.

### Adding a New Record (if allowed)

If you cannot find the record that you want in the search results, enter A at the Input field or click the **Add New Record** button at the top of the **Search Results** panel. If adding a new record is not allowed, this button is not available (grayed out). Be sure to follow your institution’s record search procedures to search existing records thoroughly before adding a new record (to reduce the occurrence of duplicate records). When you click the **Add New Record** button, the search panel is collapsed, and you are able to enter information for the new record on the UI form presented.

**Note:** The **Add New Record** button is enabled only if you accessed the **Search Results** panel by searching for records from the LookUp prompt and if the form allows you to add a new record. If you perform a person search first (before opening a form), the Add New Record button is not available because each form dictates whether new records can be added or not. If a form is open and you perform a search using the search feature rather than LookUp, the **Add New Record** button is not available. The LookUp prompt can be accessed by opening the form first or by finishing from the last person card in the Context Area.
**Filtering Results**

If your search results contain both person and organization records, you can use the filter feature to show only person records (individuals), organization records (organizations), or both (combined). To filter your search results, click the Filter drop-down and select the option that you want to use for filtering.

**Sorting Results**

You can sort search results by clicking on the column header of the displayed search results (Grid View only). To sort search results, first switch to Grid View by clicking the Grid View button at the top of the Search Results panel. You can then sort the person search results by any available column. Click once on a column header to sort the results by that column in ascending order (low to high or alphabetical), then click the column again to sort the results by that column in descending order (high to low or reverse alphabetical).

The Sort/Select option allows you to further reduce and sort the search results. In the Input field, enter $S$. You can then type a clause for the SELECT on the primary file by using constructs such as BY and WITH. If the select is not valid or finds no matching records, Colleague returns you to the main prompt with no changes. This option is not available for form searches from the form search text box. This option is available for non-form searches and LookUps performed from within a form, unless the active form LookUp prevents it.

**Searching for Results by Item Number**

To search for a specific result by item number, enter $J\ x$ in the Input field, where $x$ is the number of the specific search result that you want to jump to. This option is not available for form searches from the form search text box. This option is available for non-form searches and LookUps performed from within a form, unless the active form LookUp prevents it.
Returning to Your Most Recent Set of Search Results

To return to the most recent person search results, select the Person option in the search area and then open the Search Results panel. Select the Form option in the search area to see the most recent form search results.

Note: The Search Results panel only retains the results of the most recent form search or person search performed from the Search Area. Prior search results from LookUp prompts are not retained on the Search Results panel.

Advanced Person Search

The Advanced Person Search feature lets you search for person-related records using one or more additional criteria defined by your institution. The Advanced Person Search feature also lets you retrieve a previously saved shared list name.

To access the Advanced Person Search dialog box, click on the Advanced Search (magnifying glass with plus sign) button to the right of the Search button. See an example of the Advanced Person Search dialog box in Figure 32. You can enter criteria in one or more fields on this dialog box to search for people that meet all of the criteria specified.

Use the Shared List Name field to retrieve your own or another user’s shared list (saved list). List names are always stored in all uppercase letters, regardless of the case used when the list was created. The last ten recently created shared lists are displayed in the list. Enter the shared list name in the field or select the name from the list, and then click Search. The person records from the shared list are loaded as person search results.
**Figure 32:** Advanced Person Search Dialog Box

Advanced Search Button

Advanced Person Search Dialog Box
**Procedure for Copying a List of Favorites**

To create your own copy of a shared list of people in your Favorites, follow these steps.

**Step 1.** Make sure your Context Area is clear (no people cards loaded into it). If necessary, collapse the **Person Search Results** panel to get to the Context Area and close out all cards.

**Step 2.** From the **Advanced Person Search** dialog box, enter or select the name of the shared list you want to copy in the Shared List Name field.

**Step 3.** Click **Search**. The records from the shared list are loaded as person search results on the **Search Results** panel.

**Step 4.** From the **Search Results** panel, click **Select All**, then **Open** to load all records into the Context Area.

**Step 5.** From the Context Area, select the **Add to Favorites** (gold star) button and select **Add All to Favorites**.

**Step 6.** Create a folder for the list, and then click **Add**.

**Note:** If you save a copy of a shared list in your Favorites, remember that the list in your Favorites is a local copy. If changes are made to either the shared list or to your local copy, the lists will no longer be identical. If you want to be sure you are working with the correct and current shared list of people each time, select the shared list on the **Advanced Person Search** each time rather than selecting the copy in your Favorites.

**Form Search**

When you search for a form, the search results show all records that match the search criteria you entered.
The results are displayed in Grid View, with the results in rows and columns. Icons also indicate the type of form (maintenance, inquiry, report, or procedure). You can sort the results on any available column. You can resize the columns if needed, and you may have to scroll horizontally in the Search Results panel to see all available columns.

In most cases, when you enter a mnemonic in the form search text box, that form appears right away and the search results are not shown. If a mnemonic exactly matches the form search term entered, that form opens. If you enter a word or part of a word in the title of a form, the Search Results panel shows all forms that match the criteria entered.

Some forms require you to also select the application that you want to open them in. After you enter the mnemonic for one of those forms, Colleague prompts you for the application. You can also open those forms immediately by entering the application mnemonic and the form mnemonic together, separated with a hyphen. For example, enter "CORE-NAE" or "VAL-ST". Forms opened in this way are not stored in your search history.

When you see the Form Search Results panel, you can either select one of the forms shown or start a new search.

Note: You cannot search from the Input field for results by item number or use the Sort/Select option for form searches that were performed from the form search text box. Those options are only available for non-form searches and LookUps performed from within a form, unless the active form LookUp prevents it.

Selecting a Form

To select a form from the Form Search Results panel, click anywhere on the row for that form. You can only select one form from the Search Results panel. The selected row changes color to show which form is selected.

Opening a Form

To open a form from the Form Search Results panel, double-click on it. You can also open the selected form by clicking Open.
Adding a Form to Favorites

To add a form to your Favorites from the search results, select the form and click the Add to Favorites button (gold star) in the upper right corner of the Search Results panel.

Sorting Results

Click once on a column header to sort the results by that column in ascending order (low to high or alphabetical), then click the column again to sort the results by that column in descending order (high to low or reverse alphabetical).

Returning to Your Most Recent Set of Search Results

To return to the most recent form search results, select the Form option in the search area and then open the Search Results tab. Select the Person option in the search area to see the most recent person search results.

Note: The Search Results panel only retains the results of the most recent form search or person search performed from the Search Area. Prior search results from LookUp prompts are not retained on the Search Results panel.

Navigation Panel

Use the Navigation panel to locate a Colleague form by navigating through the Colleague menu structure. The Navigation panel shows all menus and forms that you are able to access in Colleague. To access the Navigation panel, click the Navigation tab. See Figure 33 for an example of the Navigation panel.

Select the application you want to work with from the application drop-down list at the top of the Navigation panel. When the menus load, click on a menu to expand it. Menus can include other menus, so you can continue to expand them until only forms are listed.

When you see the form you want to access, highlight it and click Open to open it. You can also double-click on the form name to open it.
In the top right corner of the Navigation panel, two buttons control how menus are expanded. Click the Single Expand button to expand only the selected menu and collapse any other menus that are currently expanded. Click the Multi Expand button to keep currently expanded menus open when you expand a new one. With this option, expanded menus will remain expanded until you explicitly collapse them.

Figure 33: Navigation Panel

[Diagram showing the Navigation panel with labels for Application Drop-Down List, Single Expand Button, Multi-Expand Button, Help for the Navigation Panel, Scroll bar, Open Button, and Panel Collapse Button]
Favorites Panel

Use the Favorites panel to retrieve and manage saved people or forms. To access the Favorites panel, click the Favorites tab. See Figure 34 for an example of the Favorites panel.

Figure 34: Favorites Panel

Adding a Person or Form to Favorites

You can add one or more people to your Favorites by clicking the Add to Favorites button (gold star) in the Context Area. When you click this button, you can choose to add only the current person to Favorites, or all people currently in the Context Area to Favorites.

To add the current form to your Favorites, click the Add to Favorites (gold star) button in the upper right corner of the UI Form area.

You can also add all active people or the active form to your Favorites by clicking the Add to Favorites button (gold star) directly in the Favorites panel, and you can add a form to your Favorites from the search results by clicking the Add to Favorites button (gold star) in the Search Results panel.

When you click the Add to Favorites button, the Add to Favorites dialog box appears. You can select an existing folder or create a new one to store the selected Favorites. For more details on how to use the Add to Favorites dialog box, click the Help button in the dialog box.
Selecting People from Favorites

To select a favorite person, navigate through the folders to locate the person record that you want to work with.

Click the record to highlight it, and then click **Open** to add that person’s record to the Context Area. You can also double-click on a record to open it.

To retrieve multiple people from Favorites, navigate through the folders and locate the people you want to work with. Highlight one person, and then use **Shift+Click** to highlight a continuous group of people. Use **Ctrl+Click** to highlight multiple people that are not in a continuous list. Click **Open** to add all highlighted people to the Context Area.

To retrieve an entire folder of people records from the Favorites panel, highlight the folder name, and then click **Open** to add all records in that folder to the Context Area. You can also double-click a folder name to add all records in that folder to the Context Area.

**Note:** To expand a folder, click the triangle to the left of the folder name.

Selecting a Form from Favorites

You can only select one form at a time from Favorites. Navigate through the folders to locate the form you want. Click the form to highlight it, and then click **Open**.

**Note:** To expand a folder, click the triangle to the left of the folder name.
Selecting People and Forms Together from Favorites

If allowed by your institution, from the Favorites panel, you can select one or more people and a person-related form at the same time. Highlight the people you want to work with, and then highlight the form you want to use. Click Open. The people are added to the Context Header, and the form is opened with the first person’s information loaded in.

Note: When selecting people and a form together, person information is only loaded into the form if it uses the person record as the primary LookUp. Otherwise, the selected people are loaded into the Context Area but not used until you open a form that uses the person record as the primary LookUp.

Managing Favorites

From the Favorites panel, you can drag items from one folder to another. You can also drag entire folders to different levels within the folder structure.

In the upper right corner of the People Favorites area and the Form Favorites area, there is an Options button with a drop-down list of available options. Use these options to manage your Favorites:

- **Create Shared List** (available only from the People Favorites Options button). Use this option to create a shared list of people records (stored as a saved list in Colleague). Select one or more people from your Favorites, or a folder of people, and then click Create Shared List to create a list that can be shared with coworkers. For example, if you create a list of students that is the definitive list of students in the class of 2012, you can share that list with other users who need to work with the same list of students. The shared list ensures that everyone works with the same group of people, and individual users do not have to create their own list. When you select this option, the Create Shared List dialog box appears. For more details on how to use the Create Shared List dialog box, click the Create Shared List Help button.

- **Recently Created Shared List**. Use this option to view the last ten recently created shared lists.

- **Collapse All**. Use this option to collapse all Favorite People or Form folders.

- **Expand All**. Use this option to expand all Favorite People or Form folders.

- **Rename**. Use this option to edit or rename a folder or item in your list of saved people or forms. Highlight the folder or item that you want to
rename, and then select Rename from the Options button drop-down menu to edit or rename the selected item.

**Note:** This option does not change the name of the person or form in Colleague. The item is renamed only in your Favorites.

- **Remove Selected.** Use this option from the People Favorite Options button to remove one or more people or people folders from your Favorites. Use this option from the Form Favorite Options button to remove one or more forms or form folders from your Favorites. Select the items that you want to remove, and then select Remove Selected from the Options button drop-down menu to remove them from your Favorites.
LookUp

Most maintenance forms require you to select a specific record to view or maintain. For example, to register a student for a course section, you must first select the student and the course section to work with.

You specify the record to work with by responding to the LookUp prompt that is displayed after you access a form. LookUp prompts are labeled according to the type of LookUp you are performing.

LookUps pertaining to people or organizations are referred to as person-related and organization-related LookUps. Examples include Person LookUp, Student LookUp, Applicant LookUp, and Vendor LookUp.

In UI, Person-related LookUps are bypassed if the form uses Person LookUp as the primary LookUp and you already have one or more person cards in the Context Area. If you access a person-related form first, and there are no person cards in the Context Area, a LookUp prompt is presented.

All LookUps show the results of the LookUp as search results on the Search Results panel.

Primary LookUps for a form are displayed as LookUp prompts that pop up as dialog boxes. However, some fields within forms are validated against other files. LookUp is used within such fields to help you locate valid codes or items that you want to associate with the main record on which you are working. When you are in a field that is validated against another file, you will see LookUp prompt text in the lower left corner of the form, as shown in Figure 35.

**Figure 35: Example LookUp Prompt Text for a Field on the NAE Form**
Using LookUp to Find Records

If you know the ID, or key, for the record that you need, you can simply enter it at the LookUp prompt. For example, Bruce Miller’s ID number is 0000205. If you enter 0000205 at the Person LookUp prompt for the Name and Address Maintenance (NAE) form, information about Mr. Miller is displayed.

Figure 36: Person LookUp Prompt

When you do not know the record ID, LookUp provides a number of options that help you find the record using the information you do have available.

For example, if you do not know Mr. Miller’s ID number, you can enter his last name at the Person LookUp prompt. If you enter “miller” at the Person LookUp prompt for the NAE form, the Person Search Results panel displays a list of all the people in your database whose names begin with “Miller.” You can then select Bruce Miller from this list.

You can use many shortcuts when working with LookUp prompts. See “LookUp Shortcuts” beginning on page 57 for more information about finding multiple records.

Note: LookUp shortcuts are also available when using the Person search feature in UI.

If the form allows you to add a person record, you are only able to add a new record by using Person LookUp. You cannot add a new record when using the Person search feature.

LookUp Shortcuts

There are a number of standard LookUp options available to help you with almost all types of LookUp.
In addition to these standard options, many types of LookUp also provide special shortcuts to help you find what you are looking for. See “Person and Organization LookUp Shortcuts” beginning on page 61 for more information about special LookUps.

**Technical Tip:** The shortcuts may be modified by your Colleague System Administrator. Please verify them with your Colleague System Administrator if they work differently in your environment. The shortcuts can also be used in search boxes.

### Standard LookUp Shortcuts

There are several LookUp shortcuts that work with most types of LookUp. LookUp options that do not work for person-related and organization-related LookUps are noted in the “Hints” column in Table 1.

<table>
<thead>
<tr>
<th>Example Scenario</th>
<th>LookUp Prompt Entry</th>
<th>Hints</th>
</tr>
</thead>
<tbody>
<tr>
<td>The last record that you displayed during this login</td>
<td>An “at” sign (@)</td>
<td>The “at” (@) sign allows you to retrieve the last form-appropriate</td>
</tr>
<tr>
<td>session.</td>
<td>For example, both</td>
<td>record that you displayed in most, but not all, cases.</td>
</tr>
<tr>
<td></td>
<td>the Name and Address</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Maintenance (NAE)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>form and the Address</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Maintenance (ADR)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>form are people-related forms. If you display Fred Smith’s record</td>
<td></td>
</tr>
<tr>
<td></td>
<td>on the NAE form, and then you access the ADR form, you can</td>
<td></td>
</tr>
<tr>
<td></td>
<td>retrieve Mr. Smith’s record on the ADR form by entering @.</td>
<td></td>
</tr>
<tr>
<td>A list of all records appropriate for this form.</td>
<td>An ellipsis (...)</td>
<td>Due to the size of Person and Organization LookUp, the ellipsis is</td>
</tr>
<tr>
<td></td>
<td></td>
<td>not supported for these files.</td>
</tr>
<tr>
<td>A list of fields in the file that contains the record</td>
<td>A semicolon (;)</td>
<td>You can use the field names to construct a query statement to look</td>
</tr>
<tr>
<td>that you are seeking.</td>
<td></td>
<td>for a record.</td>
</tr>
<tr>
<td>All records in which a specific field contains a value</td>
<td>;fieldname</td>
<td></td>
</tr>
<tr>
<td>(that is, the field is not blank).</td>
<td>For example, on the Approvals Needed (APRN) form in the Colleague</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Finance Accounts Payable module, to see a list of approval records</td>
</tr>
<tr>
<td></td>
<td></td>
<td>for individuals who are limited in the purchase order amount they</td>
</tr>
<tr>
<td></td>
<td></td>
<td>may approve, enter the following:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>;apprv.po.max.amt</td>
</tr>
</tbody>
</table>
## Table 1: Standard LookUp Shortcuts (cont’d)

<table>
<thead>
<tr>
<th>Example Scenario</th>
<th>LookUp Prompt Entry</th>
<th>Hints</th>
</tr>
</thead>
<tbody>
<tr>
<td>All records in which a specific field’s value matches a particular string.</td>
<td>;fieldname string</td>
<td>Text values, such as “Hall,” are often case-sensitive. With the exception of a person’s name, multiword values must be enclosed within double quotes. You can also look for multiple values at one time. For example, to see a list of approval records for individuals who can approve up to $10,000 or up to $15,000 on a purchase order, enter the following: ;apprv.po.max.amt 10000 15000</td>
</tr>
<tr>
<td>All records in which a specific field’s value begins with a particular string.</td>
<td>;field string...</td>
<td>Use this option when you are not sure how the item you are looking for is spelled or worded but you know how it starts. Remember that text values, such as “Typ,” are often case-sensitive.</td>
</tr>
<tr>
<td>All records in which a specific field’s value contains a particular string.</td>
<td>;fieldname ...string...</td>
<td>Use this option when you are not sure how the item you are looking for is spelled or worded but you know that it contains a certain word or part of a word. Remember that text values, such as “Typ,” are often case-sensitive.</td>
</tr>
<tr>
<td>All records in which a specific field’s value ends with a particular string.</td>
<td>;fieldname ...string</td>
<td>Use this option when you are not sure how the item you are looking for is spelled or worded but you are fairly certain about how it ends. Remember that text values such as “Wpm,” are often case-sensitive.</td>
</tr>
</tbody>
</table>

Example Scenario: LookUp Prompt Entry

- For example, on the APRN form in the Colleague Finance Accounts Payable module, to see a list of approval records for individuals who can approve up to $10,000 on a purchase order, enter the following: ;apprv.po.max.amt 10000
- For example, on the Job Skill Definition (JSKL) form in the Colleague HR Personnel module, to see a list of all job skill definitions whose descriptions begin with the word “Typing” or “Type,” enter the following: ;jsk.desc Typ...
- For example, on the JSKL form in the Colleague HR Personnel module, to see a list of all job skill definitions whose descriptions have the word “Typing” or “Type” in them, enter the following: ;jsk.desc ...Typ...
- For example, on the JSKL form in the Colleague HR Personnel module, to see a list of all job skill definitions whose descriptions end with the word “Wpm,” enter the following: ;jsk.desc ...Wpm
## Table 1: Standard LookUp Shortcuts (cont’d)

<table>
<thead>
<tr>
<th>Example Scenario</th>
<th>LookUp Prompt Entry</th>
<th>Hints</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>All records in which a specific file’s value contains several strings.</td>
<td>;fieldname ...string1...string2 or any combination of strings and ellipses to achieve the desired result. For example, on the JSKL form in the Colleague HR Personnel module, to see a list of all job skill definitions whose descriptions contained the word “Typing” followed by the number “80,” enter the following: ;jsk.desc ...Typing...80...</td>
<td>Use this option when you are not sure how the item you are looking for is spelled or worded but you know that it contains certain words or parts of words. You can use any combination of ellipses and strings to find what you are looking for. Remember that text values, such as “Typing,” are often case-sensitive.</td>
<td></td>
</tr>
</tbody>
</table>
| All records in which a specific field’s value is related in some way to a particular string (for example, is greater than or less than something). | ;fieldname operator string The following are valid operators:  
  - = or EQ (equal)  
  - <> or NE (not equal)  
  - > or GT (greater than)  
  - >= or GE (greater than or equal to)  
  - < or LT (less than)  
  - <= or LE (less than or equal to)  
  - UNLIKE (use this operator only when you use an ellipsis in specifying a data value)  

For example, on the APRN form in the Colleague Finance Accounts Payable module, to see a list of approval records that were added on or after January 1, 2009, enter the following: ;approvals.add.date ge 010109 |   |
Person and Organization LookUp Shortcuts

The information most commonly used to look for a person or organization is the name of the person or organization. Table 2 presents the LookUp shortcuts that you can use with person-related and organization-related LookUps. These shortcuts also correspond to the available options on the Advanced Person Search dialog box.

Table 2: Person-Related and Organization-Related LookUp Shortcuts

<table>
<thead>
<tr>
<th>Example Scenario</th>
<th>LookUp Prompt Entry</th>
<th>Hints</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search using a person’s name.</td>
<td>lastname (at least the first 2 letters)</td>
<td>You must enter an underscore (_) between the parts of multiword names. For example,</td>
</tr>
<tr>
<td></td>
<td>lastname, firstname</td>
<td>van_dyke, jo_anne</td>
</tr>
<tr>
<td></td>
<td>lastname, firstname middlename</td>
<td></td>
</tr>
<tr>
<td></td>
<td>lastname, firstname middleinitial</td>
<td>You can also enter only the beginning of the first and last names (at least the first two letters of the last name). For example,</td>
</tr>
<tr>
<td></td>
<td>firstname lastname</td>
<td>sm, ro</td>
</tr>
<tr>
<td></td>
<td>firstname middleinitial</td>
<td>ro sm</td>
</tr>
<tr>
<td></td>
<td>lastname, firstname</td>
<td>LookUp finds any record with a primary, birth, former, or other name like the name entered.</td>
</tr>
<tr>
<td></td>
<td>firstname middlename</td>
<td>If you choose to add a new record after looking someone up by his or her name in this manner, then regardless of how you entered the name, each word in the name is transformed into lowercase and then capitalized appropriately; for example, if you enter van_dyke, jo_anne, you would get &quot;Jo Anne Van Dyke.&quot;</td>
</tr>
<tr>
<td></td>
<td>lastname</td>
<td></td>
</tr>
<tr>
<td></td>
<td>firstname middleinitial</td>
<td></td>
</tr>
<tr>
<td></td>
<td>lastname</td>
<td></td>
</tr>
<tr>
<td></td>
<td>firstname</td>
<td></td>
</tr>
</tbody>
</table>
Table 2: Person-Related and Organization-Related LookUp Shortcuts (cont’d)

<table>
<thead>
<tr>
<th>Example Scenario</th>
<th>LookUp Prompt Entry</th>
<th>Hints</th>
</tr>
</thead>
<tbody>
<tr>
<td>Limit a name search.</td>
<td>Enter any of the following after the name:</td>
<td>You can string together more than one restriction for a search, separating each element of the search with a semicolon. For example, to find the Robert Smith whose preferred address is in Boston and who is associated with the reunion class of 1954, enter the following: robert smith ;c boston ;y 1954</td>
</tr>
<tr>
<td></td>
<td>;c city</td>
<td>For example, to find the Robert Smith whose preferred address is in Boston, enter the following:</td>
</tr>
<tr>
<td></td>
<td>;st state/province</td>
<td></td>
</tr>
<tr>
<td></td>
<td>;z zipcode/postalcode</td>
<td></td>
</tr>
<tr>
<td></td>
<td>;f country</td>
<td></td>
</tr>
<tr>
<td></td>
<td>;y class</td>
<td></td>
</tr>
<tr>
<td></td>
<td>;s source</td>
<td></td>
</tr>
<tr>
<td></td>
<td>;ps status</td>
<td></td>
</tr>
<tr>
<td></td>
<td>For example, to find the Robert Smith whose preferred address is in Boston, enter the following:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>robert smith ;c boston</td>
<td></td>
</tr>
<tr>
<td>Search using a particular Social Security or Social Insurance number.</td>
<td>;ss SSN/SIN</td>
<td>You may enter hyphens, but they are not necessary.</td>
</tr>
<tr>
<td></td>
<td>For example, Mary Browning’s Social Security number is 964-99-8765. If she gives you her Social Security number instead of her ID number, enter the following to look her up:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>;ss 964998765</td>
<td></td>
</tr>
<tr>
<td>Search using an organization’s name.</td>
<td>orgname</td>
<td>If you choose to add a new record after looking up an organization by its name, then regardless of how you entered the name, each word in the name is transformed into lowercase and then capitalized appropriately; for example, if you enter universal office supplies, you get “Universal Office Supplies.”</td>
</tr>
<tr>
<td></td>
<td>For example, to look for or add a new organization with the name of Universal Office Supplies, you could enter any of the following:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>universal</td>
<td></td>
</tr>
<tr>
<td></td>
<td>office</td>
<td></td>
</tr>
<tr>
<td></td>
<td>supplies</td>
<td></td>
</tr>
<tr>
<td></td>
<td>universal office</td>
<td></td>
</tr>
<tr>
<td></td>
<td>universal office supplies</td>
<td></td>
</tr>
</tbody>
</table>
**Table 2**: Person-Related and Organization-Related LookUp Shortcuts (cont’d)

<table>
<thead>
<tr>
<th>Example Scenario</th>
<th>LookUp Prompt Entry</th>
<th>Hints</th>
</tr>
</thead>
<tbody>
<tr>
<td>Limit a name search.</td>
<td>Enter any of the following after the name:</td>
<td>For example, if you wanted to find the Universal Office Supplies in Dayton, you could enter the following:</td>
</tr>
<tr>
<td></td>
<td>;c city</td>
<td>universal ;c dayton</td>
</tr>
<tr>
<td></td>
<td>;st state/province</td>
<td></td>
</tr>
<tr>
<td></td>
<td>;z zipcode/postalcode</td>
<td></td>
</tr>
<tr>
<td></td>
<td>;f country</td>
<td></td>
</tr>
</tbody>
</table>
Adding Records from a LookUp

You can also use LookUps to add records from certain forms.

Table 3: Adding Records from a LookUp Prompt

<table>
<thead>
<tr>
<th>Example Scenario</th>
<th>LookUp Prompt Entry</th>
<th>Hints</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preserve capitalization as entered when adding a new person.</td>
<td>=name</td>
<td>If the name is not preceded by an equal sign, then regardless of how you entered the name, each word in the name is transformed into lowercase and then capitalized appropriately.</td>
</tr>
<tr>
<td></td>
<td>For example, if you enter</td>
<td></td>
</tr>
<tr>
<td></td>
<td>=JoAnne T di_Marco</td>
<td></td>
</tr>
<tr>
<td></td>
<td>then the name is displayed exactly as you entered it.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>If you enter only</td>
<td></td>
</tr>
<tr>
<td></td>
<td>joanne t di_marco</td>
<td></td>
</tr>
<tr>
<td></td>
<td>then the name is capitalized as follows:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Joanne T. Di Marco.</td>
<td></td>
</tr>
<tr>
<td>Preserve capitalization as entered when adding a new organization.</td>
<td>=orgname</td>
<td></td>
</tr>
<tr>
<td></td>
<td>For example, if you enter</td>
<td></td>
</tr>
<tr>
<td></td>
<td>=e e cummings Institute</td>
<td></td>
</tr>
<tr>
<td></td>
<td>then the name will be displayed exactly as you entered it. If you enter only</td>
<td></td>
</tr>
<tr>
<td></td>
<td>e e cummings Institute</td>
<td></td>
</tr>
<tr>
<td></td>
<td>then the name is capitalized as follows:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>E E Cummings Institute</td>
<td></td>
</tr>
</tbody>
</table>

Note: On the Person Search Results panel, you can add new records only if you searched for records from the LookUp prompt and if the form allows you to add a new record. If you perform a person search first (before opening a form), the Add New Record button is not available because each form dictates whether new records can be added or not. If a form is open and you perform a search using the search feature rather than LookUp, the Add New Record button is not available. The LookUp prompt can be accessed by opening the form first or by finishing from the last person card in the Context Area.
Uploading and Downloading Files

With UI, you can upload and download files between your computer and Colleague if allowed by your institution. Any user can export the contents of a form table to Excel, but only users with appropriate security access can upload or download files between Colleague and their computer.

See your Colleague System Administrator if you need to upload or download files and do not have access to the required forms.

Uploading Files to Colleague

Use the Colleague File Import (FLUL) form (see Figure 37) to upload a file from your computer to Colleague. Follow the steps below to upload a file.

Figure 37: The Colleague File Import (FLUL) Form

<table>
<thead>
<tr>
<th>FLUL - Colleague File Import</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Directory</td>
</tr>
<tr>
<td>Target File Name</td>
</tr>
<tr>
<td>Execute Upload</td>
</tr>
</tbody>
</table>

**Step 1.** Access the FLUL form.

**Step 2.** Complete the Target Directory and Target File Name fields. The Target Directory must be a valid UniData directory file. See the online help for more details.

**Step 3.** Enter Yes in the Execute Upload field. A message is displayed, alerting you that the system is requesting permission to upload a file (see Figure 38).
Step 4. From the permission message, click Select File. Your computer’s file browser opens, and you can select the file you want to upload.

Step 5. From your file browser, select the file and click OK. The file is uploaded to the target directory.

Step 6. When the file upload is complete, a message is displayed. Click OK from the upload complete message to return to UI. The FLUL form is closed when you return to UI.
Downloading Files from Colleague

Use the Colleague File Export (FLDL) form (see Figure 39) to download a Colleague file to your computer. Follow the steps below to download a file.

**Figure 39: The Colleague File Export (FLDL) Form**

<table>
<thead>
<tr>
<th>Source Directory</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source File Name</td>
</tr>
<tr>
<td>Execute Download</td>
</tr>
</tbody>
</table>

**Step 1.** Access the FLDL form.

**Step 2.** Complete the Source Directory and Source File Name fields. The Source Directory must be a valid UniData directory file. See the online help for more details.

**Step 3.** Enter Yes in the Execute Download field. A message is displayed, alerting you that the system is requesting permission to download a file (see Figure 40).

**Figure 40: Permission to Download Dialog Box**

<table>
<thead>
<tr>
<th>Download File</th>
</tr>
</thead>
<tbody>
<tr>
<td>The system is requesting permission to save a file to your computer.</td>
</tr>
<tr>
<td>Choose Save As to save the file or Cancel.</td>
</tr>
<tr>
<td>![Save As Button]</td>
</tr>
</tbody>
</table>

**Step 4.** From the permission message, click Save As. Your computer’s file browser opens, and you can select the location and file name for the file that you are about to download.

**Step 5.** From your file browser, select the file and click OK. The file is downloaded to the selected folder on your computer.
Step 6. When the file download is complete, a message is displayed. Click OK from the download complete message to return to UI. The FLDL form is closed when you return to UI.
Running Batch and Report Processes

Some Colleague forms let you specify information required to process data without further interaction (a batch process) or to create a report (a report process). When you run batch and report processes, a bar graph or message displays the progress of each process.

**Note:** Bar graphs and messages are not displayed when a batch or report is run in background mode.

Batch and report processes display a progress bar dialog box to visually indicate progress (see Figure 41). Some show messages within the progress bar dialog box. For batches and reports that process only one item, the top and bottom progress bars both indicate overall progress. For batches and reports that process multiple items, the top progress bar indicates overall progress, and the bottom progress bar indicates progress for the current item being processed. The window at the bottom of the progress bar dialog box displays any messages related to the progress status.

When the batch or report process is completed, click **Finish** to return to Colleague. To return to Colleague automatically when the process completes without having to click **Finish**, select the **Close automatically when complete** check box.

**Figure 41:** Batch and Report Progress Bar Dialog Box
Using the Report Browser

The Report Browser allows you to view or print reports generated from Colleague. Follow the procedure below to generate and browse a report in Colleague.

Procedure for Browsing a Report

To use the Report Browser, perform the following steps.

**Step 1.** Access and complete the Colleague form that creates the desired report. Some batch processes provide an option for producing a report of the data processing changes made. Figure 42 shows an example of the Update Mail Codes (UMAI) form, which is a batch process that includes an option for generating a report. When you update from the form, the Peripheral Defaults form is displayed.

*Note:* For batch processes that can optionally generate a report, the Peripheral Defaults form is displayed only if you choose to generate a report (as shown in the Print Report field in Figure 42).

**Figure 42: Update Mail Codes (UMAI) Form**

![Update Mail Codes (UMAI) Form](image)

Add Mail Code: Do Not Contact at Work
Delete Mail Code: Yes
Print Report: Yes

Saved List Name: 

Person 1: 0000205 Dr. Bruce Miller
Person 2: 0000007 Ms. Carla Miller
Person 3: 0000400 Mr. Michael S. Miller
Person 4:
Person 5:
Person 6:
Person 7:
Person 8:
Person 9:
Person 10:

Additional Selection Criteria: No
Step 2. In the Output Device field on the Peripheral Defaults form (see Figure 43), select **Hold/Browse File Output**. When you update from the Peripheral Defaults form, the Process Handler form is displayed.

**Figure 43: Output Device Field: Peripheral Defaults Form**
Step 3. Complete the Process Handler form (see Figure 44). When you update from the Process Handler form, the batch process runs and the report is generated.

Note: The batch or report process displays the progress bar dialog box only if you entered No in the Execute in Background Mode field on the Process Handler form. See “Running Batch and Report Processes” on page 69 for more information about the progress bar dialog box.

Figure 44: The Background Mode Form

![Image of the Background Mode Form]

Step 4. If the progress bar dialog box is displayed, monitor the progress of the batch or report and click Finish when processing is complete.

Figure 45: Progress Bar Dialog Box

![Image of the Progress Bar Dialog Box]
Step 5. When you click Finish from the progress bar dialog box, the Report Browser is displayed. Figure 46 shows a typical report page in the Report Browser.

**Figure 46: Report Browser**

![Report Browser Diagram]

Step 6. Use the toolbar buttons, shown in Figure 47, to navigate through the report pages, save a copy of the report, export the report to a PDF file, or print the report.

**Figure 47: Report Browser Toolbar Detail**

![Report Browser Toolbar Diagram]
The Report Browser Toolbar buttons are described in Table 4.

**Table 4: Report Browser Toolbar Buttons**

<table>
<thead>
<tr>
<th>Button</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="Image" alt="Help" /></td>
<td>Report Browser Help</td>
<td>Opens the Report Browser help.</td>
</tr>
<tr>
<td><img src="Image" alt="Close" /></td>
<td>Exit Report Browser</td>
<td>Closes the Report Browser and returns to the Colleague UI window.</td>
</tr>
<tr>
<td><img src="Image" alt="FirstPage" /></td>
<td>First Page</td>
<td>Jumps to the first page of the report.</td>
</tr>
<tr>
<td><img src="Image" alt="PreviousPage" /></td>
<td>Previous Page</td>
<td>Moves to the previous page of the report.</td>
</tr>
<tr>
<td><img src="Image" alt="CurrentPage" /></td>
<td>Current Page/Total Pages/Change Page</td>
<td>Shows the number of the currently displayed page and the total number of pages in the report. You can also jump directly to any page by typing the page number in this field and then pressing Enter.</td>
</tr>
<tr>
<td><img src="Image" alt="NextPage" /></td>
<td>Next Page</td>
<td>Moves to the next page of the report.</td>
</tr>
<tr>
<td><img src="Image" alt="LastPage" /></td>
<td>Last Page</td>
<td>Jumps to the last page of the report.</td>
</tr>
<tr>
<td><img src="Image" alt="SaveAs" /></td>
<td>Save As</td>
<td>Saves a copy of the report to your network or local hard drive. You are prompted to specify a name and path for the saved report.</td>
</tr>
</tbody>
</table>
Export PDF Exports the report as a PDF file. When you select this option, the Export to PDF dialog box is displayed with various formatting options for the PDF file. The formatting options are retained for the current UI session only.

The Export to PDF dialog box contains the following options:

- **Font**: Select the font to be used for the text within the PDF file. Options include Courier, Helvetica, or Times New Roman. The default font is Courier.
- **Font Size**: Enter the font size to be used for text within the PDF file. Enter a value from 1 to 100. The default font size is 10.0.
- **Orientation**: Select whether the text within the PDF file should be displayed in the portrait or landscape orientation. The default page orientation is portrait.
- **Paper Size**: Select the paper size of the PDF file. Options include Letter (8.5 x 11 in.), Legal (8.5 x 14 in.), Executive (7.25 x 10.5 in.), or Tabloid (11 x 17 in.). The default page size is Letter.

**Note**: For best results when exporting a PDF file, you must choose an appropriate font size and page orientation. If the font is too large, the report may not page properly or may line wrap at the right margin. For reports that are up to 80 characters wide, use a font size of 10 and portrait orientation. For reports that are between 81 and 132 characters wide, use a font size of 8 and landscape orientation.

Click Create PDF to create and save the PDF file. You can then open the PDF file in Adobe Reader. Alternatively, you can view PDF files directly in your browser (rather than downloading and saving them first). To do this, in Adobe Reader, make sure that the **Display PDF in browser** option is enabled in the Preferences window. You can typically access this option from the **Edit > Preferences** menu, Internet area.
Table 4: Report Browser Toolbar Buttons (cont’d)

<table>
<thead>
<tr>
<th>Button</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Print Remote]</td>
<td>Print Remote</td>
<td>Prints the report to a printer that is accessible from the Colleague host computer. This option uses the Colleague host operating system to print the report, without downloading it to your computer.</td>
</tr>
<tr>
<td>![Show Full Page View]</td>
<td>Show Full Page View</td>
<td>Displays one full vertical page of a report in the Report Browser without scrolling. The default preference is to display the full page view, though you can override the preference using this option, and you can also change the preference from the <strong>Options &gt; Preferences</strong> menu. The option that is last used in the Report Browser will be used the next time the Report Browser is displayed.</td>
</tr>
</tbody>
</table>

**Technical Tip:** Most PDF readers will scale a PDF document to fit the printer margins defined by the printer's print driver. If you are printing a document that requires a specific font size when it is printed, then you can compensate for this scaling when exporting the PDF. See **AnswerNet page 8620** for more information.
Accessing Multiple Environments

When your Colleague System Administrator installs UI, each installation is specific to one Colleague environment. Your administrator will provide you with the web address (URL) for accessing each environment that is set up for use with UI.

If you need to access a specific Colleague environment with UI and do not have connection or login information, see your Colleague System Administrator.
Keyboard Shortcuts

This section lists the keyboard shortcuts that you can use with UI.

The shortcuts listed below are available in UI when your cursor is not within a UI form:

Note: Some of these shortcuts may not work in all browsers. Browser plug-ins or other applications may override these shortcuts and activate different commands.

- Change focus to search box (toggles between Person and Form search): Ctrl+Shift+S
- Show Search Results panel: Ctrl+Alt+R
- Show Clear History dialog box: Ctrl+Alt+T
- Show Advanced Person Search dialog box: Ctrl+Alt+A
- Show Navigation Panel: Ctrl+Alt+N
- Show Favorites Panel: Ctrl+Alt+F
- Exit/Logout: Ctrl+Alt+L
- Show Debug Information: Ctrl+Alt+B
- Show Help (for current UI area in focus): Ctrl+Alt+H
- Show Keyboard Shortcuts: Ctrl+Alt+K
- View all records in Context Area (card selector drop-down): Ctrl+Shift+A
- Map current record in Context Area: Ctrl+Shift+M
- Map all records in Context Area: Ctrl+Alt+M
- Close current record in Context Area: Ctrl+Shift+X
- Close all records in Context Area: Ctrl+Alt+X
- Add current record in Context Area to Favorites: Ctrl+Shift+V
- Add all records in Context Area to Favorites: Ctrl+Alt+V
- Go to next record in Context Area: Ctrl+Shift+N
- Go to previous record in Context Area: Ctrl+Shift+R
- Open Copy Window for current card in Context Area: Ctrl+Shift+C
- Toggle screen reader short/verbose search results help: Ctrl+Alt+J
- Change focus to a UI form (places focus in the last field that previously had focus; only works if a form is open): Ctrl+Shift+W
- Change focus to the Context Area (works even if no active context card is displayed): Ctrl+Alt+W
- Close open panels (and return to the main UI window): Esc
The keyboard shortcuts listed below are available only when working within a UI form (alternative keystroke combinations are separated by |). Most of these commands are also accessible with the mouse from the UI form menu.

**Note:** On some Mac keyboards, Command+Up/Down Arrow is used instead of Page Up or Page Down. Users with these types of keyboards may also need to press Fn for shortcuts that use Command+Page Up/Page Down.

**Note:** Some of these shortcuts may not work in all browsers. Browser plug-ins or other applications may override these shortcuts and activate different commands.

- Move to the next field: Tab
- Move to the previous field: Shift+Tab
- Open a drop-down list to select a value: Down Arrow
- Scroll through the values in a drop-down list: Up/Down Arrow
- Select the highlighted value in the drop-down list: Enter
- Move forward one row in a table: Down Arrow *
- Move back one row in a table: Up Arrow *
- Move forward one page in a table: Page Up
- Move backward one page in a table: Page Down
- Move to the previous form: Ctrl+Page Up (Windows) | Command+Page Up (Mac)
- Move to the next form: Ctrl+Page Down (Windows) | Command+Page Down (Mac)
- Move to the beginning of the current field: Home
- Move to the end of the current field: End
- Move to the first row of a table: Ctrl+Home
- Move to the last row of a table: Ctrl+End
- Field insert in a table: Insert
- Field delete in a table: Ctrl+Alt+D
- Cancel from current form: F8
- Cancel from all forms: Shift+F8
- Finish from current form: Ctrl+F9 (Windows) | Ctrl+9 (Mac)
- Save current form: F9 | Ctrl+0 (zero, not the letter o)
- Save all open forms: Shift+F9 (Windows) | Ctrl+8 (Mac)
- Detail: F2
- Print active form: Ctrl+Alt+P
Help: Ctrl+Alt+H | F1 (shows help for area currently in focus; F1 may not work in all instances)

Change focus to UI Form Menu Bar (then use tab and arrow keys to access menu items): Ctrl+U

Show Keyboard Shortcuts: Ctrl+Alt+K

Read all Inquiry fields on a form (with screen reader software): Ctrl+Alt+I

*If the current field within a table has a drop-down list, use Down Arrow to open the list, Up/Down Arrow to move up and down within the list, and Ctrl+Up or Ctrl+Down to move back or forward one row.
Using UI Without a Mouse

Most of the UI features can be accessed with either a mouse or a keyboard. If you are a keyboard-intensive data entry user, you should be able to navigate a form and access most of the data-entry-related features using the keyboard rather than switching back and forth between the keyboard and mouse.

If you are a keyboard-intensive data entry user, keep the following points in mind:

- Study and learn the keyboard shortcuts shown in “Keyboard Shortcuts” beginning on page 78. Be aware that some of these shortcuts are different between Mac and Windows computers. If you happen to use both types of computer, familiarize yourself with both. You can access the keyboard shortcuts when working with Colleague by pressing Ctrl+Alt+K. If you are on a Windows computer, only the Windows version of the keyboard shortcuts is shown when you access the list of keyboard shortcuts. If you are on a Mac computer, only the Mac version is shown.

- Not all menu options have a shortcut. However, you can still access all menu items using the keyboard. Press Ctrl+M to access the menu bar, then you can use the arrow keys to highlight the menu item you want, then press Enter to select it.

- Some UI features that are not critical to data entry do not have shortcuts. For example, the controller that lets you page through a table within a UI form does not have a keyboard shortcut for exporting to Excel or for sliding the controller left or right if it is blocking your view of another field. However, keyboard shortcuts do exist for paging through the rows, columns, and pages of a table.

- For validated fields (ones with a drop-down to select a predetermined value) within a table, you need a way to access and select an item from the drop-down list in addition to a way to move to the next row. Normally, the up or down arrow moves to the previous or next row of a table, but for fields with drop-down lists, the down arrow key opens the drop-down list. When the list is opened, you can use the up and down arrow keys to scroll through the list and select a value. However, if you are on a validated field within a table, press Ctrl+Down or Ctrl+Up to move to the next or previous row.
Viewing Online Help in UI

Online help provides you with detailed information about areas of the UI interface or Envision forms. A question mark icon is available on most UI areas, such as the Context Area, Search Results panel, Navigation panel, Favorites panel, and dialog boxes. Within a UI form, the traditional process, field, and how-to help is available for the form from either the UI Form Help icon or from the Help menu.

Figure 48: Accessing Online Help in UI

Figure 49 shows an example of the help available for UI areas such as the Context Area or Search Results panel.
The title of the help page indicates the UI Area for this help topic.

The help Search text box lets you search for information in manuals (PDF files) and Tech Doc Online.

For all UI Area help topics, a single page of information specific to the UI Area is shown.
Figure 50 shows an example of the online help available for a UI Form. Contact your Colleague System Administrator if the format of your help is displayed incorrectly.

**Figure 50: Example of UI Form Help**

- The title of the help page indicates the UI Form for this help topic.
- Process and field help for the current form is available in this section of the help page. Select View all help for this form to see all process and field help for the current form.
- The help Search text box lets you search for information in manuals (PDF files) and Tech Doc Online.

Online procedural help topics relevant to this UI form are listed in this section of the help page.

PDF files and Tech Doc Online pages relevant to this UI Form are listed in this section of the help page.
Customizing Colleague UI

In This Chapter

This chapter helps you learn how to customize the look and feel of Colleague User Interface. It includes instructions for defining user preferences, setting Favorites, and customizing the field sequence for Colleague forms.
Defining User Preferences

Many personal preferences for UI can be set on the Preferences dialog box (see Figure 51). Changes to these preferences apply to your user profile only.

To access the Preferences dialog box, select Options > Preferences from the menu bar.

Figure 51: Preferences Dialog Box

Click on the Layout section header to expand it and view or change the following:

- **Color Theme.** Select one of the available color themes. A preview of the color theme is shown.

- **Form Background Color.** Select one of the available background colors for UI forms.

Click on the Miscellaneous section header to expand it and view or change the following:

- **Display Person Photos.** If person photos are enabled at your institution, you can turn them on or off here for your own user profile.

**Note:** If photos are disabled at your institution, or if your security settings do not allow access to photos, then changing this option has no effect on your ability to see photos.
- **Number of Search Results Per Page.** When search results are displayed, you can define how many results are included on a page. Adjust this number to avoid having to scroll within the Search Results panel to see an entire page of results. The Card View setting applies only to person search results (card view).

- **Automatically Close Bar Graph When Finished.** Select this check box to close the Bar Graph window and return to the UI form when processing is complete. If you leave this option cleared, the Bar Graph window will stay open after processing is complete, and you must close it manually to return to the UI form. See “Running Batch and Report Processes” beginning on page 69 for more details about this feature.

- **Play Sound on Popup Messages.** Select this check box to play an alert sound when an error or other important dialog box is displayed.

- **Verbose Search Result Accessibility Properties.** Select this check box to have screen reader software read every property in the Search Results panel and Context Area. The default screen reading mode will only read the ID and full name. If this item is not selected as a preference, you can still use the keyboard shortcut (Ctrl+Alt+J) to read every property in the Search Results panel.

- **Show Full Page Report Browser View.** Select this check box to display one full vertical page of a report in the Report Browser without scrolling. This option, which is selected by default, sets the preference for each time the Report Browser is displayed, though you can override this option in the Report Browser. The option that is last used in the Report Browser will be used the next time the Report Browser is displayed.

You can restore all default settings by clicking **Restore Default Settings.**

Click **Apply** to save your changes but keep the Preferences dialog box open.

Click **Cancel** to discard your changes and close the Preferences dialog box.

Click **OK** to save your changes and close the Preferences dialog box.

If you are using UI through Colleague Portal, the **Modify Your UI Single Sign-On Credentials** link is available. Click this link if your UI sign-on credentials change and you need to reset them for single sign-on access through the Portal.
Adding and Accessing Favorites

You can use the Favorites feature to save forms and person records that you use frequently to the Favorites panel, so that you can access them quickly.

Adding Favorites

Use the Add to Favorites feature to add the current form or people to your list of Favorites.

You can access the Add to Favorites dialog box (see Figure 52 for an example of the Add Person to Favorites dialog box) by clicking the Star icon in the UI form area, form search results, the Context area, or in the Favorites panel, or by using one of the following keyboard shortcuts:

- Add current person in Context Area to Favorites: Ctrl+Shift+V
- Add all person records in Context Area to Favorites: Ctrl+Alt+V

Figure 52: Add Person to Favorites Dialog Box
Adding and Accessing Favorites

Guide to User Interface 4.4 and 4.4.1, May 2, 2013

Complete the following fields on the Add to Favorites dialog box to add items to your list of Favorites:

- **Name.** Shows the name of the person (one or more) or the form (only one) that you have selected to add to Favorites.

- **Add to Folder.** Select an existing folder from the drop-down list, or click **New Folder** to create a new folder for the selected items. You can create nested folders if needed.

- Click **Add** to add the listed items to the selected Favorites folder.

- To view and manage your existing Favorites, click the **Favorites** tab at the top of the UI window to open the **Favorites** panel.

Accessing Favorites

Use the **Favorites** panel to retrieve and manage saved People, if allowed, or Forms Favorites.

You can access the **Favorites** panel by clicking the **Favorites** tab at the top of the UI window or by using the keyboard shortcut: **Ctrl+Alt+F**.
Selecting People (if allowed) from Favorites

If allowed by your institution, to select one person from Favorites, navigate through the folders to locate the person record that you want to work with.

**Note:** To expand a folder, click the triangle to the left of the folder name. Double-clicking a folder name will add all person records in that Favorites folder to the Context Area.

Click the record to highlight it, and then click **Open** to add that person’s record to the Context Area. You can also double-click a record to open it.

To select multiple people from Favorites, navigate through the folders and locate the person records that you want to work with. Use **Shift+Click** to highlight a continuous group of records. Use **Ctrl+Click** to highlight multiple records that are not in a continuous list. When using **Ctrl+Click**, you can click again on a highlighted record to cancel that selection. Click **Open** to add all highlighted people records to the Context Area.
To retrieve an entire folder of people records from the Favorites panel, highlight the folder name, and then click **Open** to add all records in that folder to the Context Area. You can also double-click a folder name to add all records in that folder to the Context Area.

**Note:** To expand a folder, click the triangle to the left of the folder name.

### Selecting a Form from Favorites

You can select only one form at a time from the Favorites panel. Navigate through the folders to locate the form you want. Click the form to highlight it, and then click **Open**.

**Note:** To expand a folder, click the triangle to the left of the folder name.

### Selecting People (if allowed) and Forms Together from Favorites

From the Favorites panel, you can select one or more people records and a person-related form at the same time. Highlight the people records that you want to work with, and then highlight the form you want to use. Click **Open**. The people are added to the Context Area, and the form is opened with the first person’s information loaded in.

**Note:** When selecting people and a form together, person information is loaded into the form only if the form uses the Person record as the primary LookUp. Otherwise, the selected people are loaded into the Context Area but not used until you open a form that uses the person record as the primary LookUp.

### Managing Favorites

From the Favorites panel, you can drag items from one folder to another. You can also drag entire folders to different levels within the folder structure.

In the upper right corner of the People Favorites area and the Form Favorites area, there is an **Options** button with a drop-down list of available options. Use these options to manage your Favorites:

- **Create Shared List** (available only from the People Favorites **Options** button). Use this option to create a shared list of people records (stored as a
saved list in Colleague). See “Creating a Shared List from Favorites” on page 92.

- **Recently Created Shared List.** Use this option to view the last ten recently created shared lists.

- **Collapse All.** Use this option to collapse all Favorite People or Form folders.

- **Expand All.** Use this option to expand all Favorite People or Form folders.

- **Rename.** Use this option to edit or rename a folder or item in your list of saved people or forms. Highlight the folder or item you want to rename, and then select **Rename** from the **Options** button drop-down menu to edit or rename the selected item.

**Note:** This option does not change the name of the person or form in Colleague. The item is renamed only in your Favorites.

- **Remove Selected.** Use this option from the People Favorite **Options** button to remove one or more people or people folders from your Favorites. Use this option from the Form Favorite **Options** button to remove one or more forms or form folders from your Favorites. Select the items that you want to remove, and then select **Remove Selected** from the **Options** button drop-down menu to remove them from your Favorites.

**Creating a Shared List from Favorites**

Follow these steps to create a shared list of people records from existing People Favorites. For example, if you create a list of students that is the definitive list of students in the class of 2012, you can share it with other users who need to work with the same list of students. The shared list ensures that everyone works with the same group of people, and each user does not have to create his or her own list individually.

**Step 1.** Select one or more people from your Favorites, or a folder of people.

**Step 2.** From the People Favorites area of the Favorites panel, open the **Options** button and select **Create Shared List.** The **Create Shared List** dialog box appears (see Figure 54).
**Step 3.** Complete the Shared List dialog box as follows:

a. **Shared List Items:** Shows the names of the people selected from your Favorites that will be stored in the shared list that you are about to create.

b. **Shared List Name:** Enter the name to use for the shared list. This list is stored as a saved list in Colleague. Be sure to follow your institution’s naming conventions when saving the shared list. If you enter a shared list name that already exists, you will be prompted whether to overwrite it. The saved list name is stored in all uppercase letters, regardless of the case used when creating the name. Click the **Recently Created Shared Lists** link to view the last ten recently created shared lists.

**Step 4.** Click **Create** to create the shared list and exit the **Create Shared List** dialog box. The shared list is created in Colleague as a saved list.

**Step 5.** You or any other user in this Colleague environment can retrieve an existing shared list from the **Advanced Person Search** dialog box (see “Advanced Person Search” beginning on page 46 for more information). When another person retrieves this shared list, privacy settings and record security are applied to ensure that the user does not access restricted information.
Customizing the Field Sequence and Properties for a Form

The behavior for each field on each form is originally defined by Ellucian. The Colleague System Administrator at your institution can use Colleague Studio to further define and customize field behavior. If allowed by your institution, you can also modify certain field behaviors for the forms that you access.

**Note:** Before you can customize fields for a form, your Colleague System Administrator must first enable the field customization features for you and set up your field customization preferences.

You can use field customization to determine the tab sequence of fields on a form. Customizing your field sequence can help you move through a form more quickly than you would if you had to tab through each field on the form. You can specify the field you want to start in first, the order in which to visit each subsequent field, and the last field to complete before updating from the form. Each time you press the Tab or Enter key, you move to the next field in the specified tab sequence (skipping any fields not in the tab sequence). If you specify a last field, the form updates when you tab from the last field in your customized tab sequence. If tab sequencing is not specified, the default sequence is used.

Use the **Customize Field Sequence & Properties** dialog box (available from the Options menu) to specify field sequence and field access for fields on the current form (see Figure 55). The example in Figure 55 shows field customization properties for the NAE form. Any form can be customized if you are allowed to customize the field properties.

The **Customize Field Sequence & Properties** dialog box includes the following options for customization:

- **Field Sequence.** Lets you specify a first field, last field, and next field for tab sequence.
- **Field Access.** Lets you specify which fields on the form are Required, Inquiry Only, or No Access.

When you access the **Customize Field Sequence & Properties** dialog box for a form, a series of “tool tips” indicates the field identifier number and tab sequence of each field. Tool tips are the numbered boxes displayed on each field when you open the **Customize Field Sequence & Properties** dialog.
box. Field identifier number tool tips are shown in yellow boxes, and tab sequence tool tips are shown in orange boxes. A green tool tip for a field indicates that the field properties are customized for that field.

See “Procedure for Customizing Fields on a Form” beginning on page 97 for the procedure for customizing the field sequence for a form.

**Figure 55**: Customize Field Properties Dialog Box for the NAE Form
Limitations on Customizing Field Properties

Field Sequence Customization Limitations

The behavior for each field on each form is originally defined by Ellucian. System administrators can use Colleague Studio to further define field behavior for an institution. You cannot take away behavior that is already defined for fields on a form. The following rules apply when customizing field sequences:

- **Precedence**
  - Tab sequence precedence is exclusive. If your Colleague System Administrator creates a tab sequence and applies it to some or all users, you can still create a different tab sequence for yourself (if allowed), and that tab sequence will apply only to your login ID.

- **First Field**
  - You can make only one field first in the sequence. Therefore, if another field has already been specified as the form’s first field, locate that field and clear the selection.

- **Last Field**
  - You can specify more than one field as the last field on a form. However, when specifying a field as last, you cannot also select a next field override.

- **Next Field Override**
  - If a field is specified as last, you cannot select a next field override.
  - Other fields that cannot have a next field override include:
    - Fields contained in the header area.
    - Table fields that are not table controllers (unless the current field is a member of the same table).

Field Access Customization Limitations

When customizing the field access properties, you cannot take away behavior that either Ellucian or your Colleague System Administrator has already defined for the fields on a form. For example, if a field is defined as Required,
it is always required and cannot be changed to Inquiry Only or No Access. However, a standard (not required) data entry field can be customized as required.

**Precedence**

- Field access precedence is inclusive. If your Colleague System Administrator restricts field access from a field for all users, you cannot customize the field access properties to allow access to that field for yourself.

**Field Access**

- Fields appearing in the form’s header area can only have No Access restrictions applied to them. Only the visible fields in the header area can be set to No Access.
- You can only apply one field access restriction (Required, Inquiry Only, or No Access) to a field.
- If a field is already specified as **required**, you cannot modify any of the access options.
- If a field is already specified as **no access** by Envision security, you cannot modify any of the access options.
- If a field is already specified as **inquiry-only**, your only available field access customization option is to specify the field as **no access**.

## Procedure for Customizing Fields on a Form

This procedure assumes that your Colleague System Administrator has provided you with the ability to customize field properties for Colleague forms. If you do not have access to this feature, see your Colleague System Administrator.

**Step 1.** Access the form that you want to customize.

**Step 2.** From the **Options** menu, select **Customize Field Sequence & Properties** to display the **Customize Field Sequence & Properties** dialog box (see **Figure 56**). When the dialog box is displayed, the tool tips on the current form are also displayed.
Step 3. In the When I am on field drop-down list, select the number of the field you want to modify. Refer to the field identifier tool tips displayed on the form to select the number of the field you want to modify.

Step 4. Indicate the field sequence customization you want to apply to the field.

- To set a field as first in the form, select the appropriate field number from the When I am on field list and then select the Make this the first field on the form check box. When entering the form, the cursor will appear in this field, which is the first field in the form’s tab sequence.
- To set a field as last in the form, select the appropriate field number from the When I am on field list and then select the Make this the last field on the form check box. This is the last field in a form’s tab sequence, which means the form will update and you will leave the form after you leave this field.
- In the The next field should be list, you can specify where the cursor should move when leaving the field currently selected in the When I am on field list. If you do not select a field override from this list, the next field in the default tab sequence is used. For example, if you want to enter data into field 10 on a form then move directly to field 15, select 10 from the When I am on field list, and then select 15 in this list. Refer to the field identifier tool tips displayed on the form to select the number of the field you want to modify.

Step 5. Indicate the level of field access that you want to apply to the selected field.

- Select the Required check box to ensure that the field currently indicated in the When I am on field list is completed before finishing from the selected form.
- Select the Inquiry Only check box to make the field currently indicated in the When I am on field list non-editable. This option lets you view data in this field, but you cannot update or delete data.
- Select the No Access check box to prevent viewing, adding, changing, or deleting data from the field currently indicated in the When I am on field list.
Customizing the Field Sequence and Properties for a Form

Review the “Field Access Customization Limitations” on page 96 for an explanation of which options are available for each field. Any changes made that violate the customization limitations will appear to be saved, but these changes will not be honored.

**Step 6.** Repeat steps 3 through 5 for each field that you want to customize.

**Note:** You do not need to click Save after customizing each field. You can click Save after making customizations to all of the fields on a form to apply all of the customizations. Clicking Save will save all changes and exit the dialog box.

Click Clear This Field to remove customizations for the currently selected field and return to the default settings. Customizations for all other fields on this form are left unchanged.

Click Clear All Fields to remove all existing field customizations for the current form and return to the default settings.

**Step 7.** Click Save when you have finished your field customization settings to save all changes and exit the dialog box. Test your field customizations and adjust them as needed until the form behaves the way you expect it to. You must close and then reopen the form you have customized to test it.

**Step 8.** If allowed by your institution, you can copy the current customizations to a specific set of users. Click the Copy to other users link and select the users from the list to whom you want to copy the current set of customizations. After selecting the users, click Copy and then Save to submit the customizations to those users and exit the Customize Field Sequence & Properties dialog box.

Users listed in bold red text have existing customizations. Copying customizations to users will overwrite any existing customizations that those users have defined. Additionally, copying does not establish a permanent link; therefore, further changes made after copying will not be reflected for those users.

**Procedure for Disabling Field Sequence**

After you set up custom field sequencing, there may be a situation where you need to temporarily disable your customizations. Follow this procedure to disable and then re-enable your field sequence customizations. This feature
disables only your own customizations. If your Colleague System Administrator has customized this form for all users, those customizations cannot be disabled.

**Note:** This option does not disable field access level customizations.

**Step 1.** Access the form that you customized.

**Step 2.** From the Options menu, select **Disable Custom Field Sequence**. If this option is not selected, it indicates that the field customizations are in place. If this option is checked, it indicates that the field customizations are temporarily disabled. To temporarily disable the field customizations, make sure this option is checked.

**Step 3.** To re-establish your custom field sequence changes, clear the **Disable Custom Field Sequence** option.

**Procedure for Showing Field Sequence**

You can display the current field sequence of the current form. The field sequence for each field is displayed as a number in the tool tip for that field. Any fields with customizations appear with green tool tips. The fields with default field sequence settings appear with orange tool tips.

**Step 1.** Access the form for which you want to see the field sequence.

**Step 2.** Select **Options > Show Field Sequence**. Tool tips appear for each field on the form. The number in each tool tip indicates its field sequence.

**Step 3.** To hide the tool tips showing the field sequence and return to the form, click anywhere on the form.